
If you want control … you need the right connections

“ErgoTorq”TM

Patented product’s specifically designed to provide solutions to
pulse and nutrunner assembly tooling Safety, Ergonomic, Quality, 

Reliability and Cost Down problems. 

Guided Extension                 
“Collar”

“Ultralite” extensions 

weigh up to 50% less

Standard                                
“PinchPoint Protector”

Pulse tool guided 
quick change 
“Adapters”

Pulse tool Guided Sockets 
& Socket “Adaptors”

“Dual-drive” Socket Allows the 
rundown two different size fasteners 

with the same socket. 

Pulse tool guided extensions 
& extended sockets

Attachment Covers

“ErgoTorq”TM

Assembly Tooling 
Accessories

“Non-Rotating”

“Slip Type”

“Non-rotating/Retractable”        
Bit Holder Cover

NEW !

Durability 
tested to 
100,000 
cycles !

Superior selection, performance and delivery, at reduced cost !



Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tool Part #'s

“ErgoTorq” 

““GGuuiiddeedd””  PPuullssee  TTooooll  EExxtteennssiioonnss  
(U.S. Patent #6,321,855) 

 

Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tool Part #'s

3/8" Square Drive 1/2" Square Drive  

Atlas Copco Pulse Tool Part #'s

3/8" Square Drive 1/2" Square Drive 

"Ultralite" Pulse Tool Extensions Up to 50% lighter than standard extensions !!!

"Standard Weight" Pulse Tool Extensions

(*)Fuji models with exposed anvil behind square drive of > .385"

3/8" Square Drive 1/2" Square Drive 

Atlas Copco Pulse Tool Part #'s

3/8" Square Drive 1/2" Square Drive 

(*)Fuji models with exposed anvil behind square drive of > .385"

A perfect match 
for light weight 
pulse tooling!

Length Part#
4" AREX3-4(1)
6" AREX3-6(1)
8" AREX3-8(1)
10" AREX3-10(1)
12" AREX3-12(1)

Length Part#
4" AREX4-4(3)
6" AREX4-6(3)
8" AREX4-8(3)
10" AREX4-10(3)
12" AREX4-12(3)

Length Part#
4" ARUEX3-4(1)
6" ARUEX3-6(1)
8" ARUEX3-8(1)
10" ARUEX3-10(1)
12" ARUEX3-12(1)

Length Part#
4" ARUEX4-4(3)
6" ARUEX4-6(3)
8" ARUEX4-8(3)
10" ARUEX4-10(3)
12" ARUEX4-12(3)

Superior selection, 
performance and 
delivery then any 

competitors product 
at reduced cost !

Durability tested 
to 100,000 cycles !

Length Part#
4" AREX4-4(5)
6" AREX4-6(5)
8" AREX4-8(5)
10" AREX4-10(5)
12" AREX4-12(5)

Length Part#
4" AREX3-4(2)
6" AREX3-6(2)
8" AREX3-8(2)
10" AREX3-10(2)
12" AREX3-12(2)

Length Part#
4" ARUEX3-4(2)
6" ARUEX3-6(2)
8" ARUEX3-8(2)
10" ARUEX3-10(2)
12" ARUEX3-12(2)

Length Part#
4" ARUEX4-4(5)
6" ARUEX4-6(5)
8" ARUEX4-8(5)
10" ARUEX4-10(5)
12" ARUEX4-12(5)

* Standard &"Ultralite" extensions are available in any length and drive end configuration 
Simply ask your ErgoTorq Authorized Distributor for a quote or use our online quote form at www.ergotorq.com)



“ErgoTorq” 

““GGuuiiddeedd””  SSoocckkeettss  FFoorr  PPuullssee  TTooooll  ttoo  SSoocckkeett  AApppplliiccaattiioonnss  
(U.S. Patent #6,321,855) 

 Superior selection, performance and delivery then any competitors product at reduced cost ! 

Pulse Tool 6 Point, Standard Length, Non-Magnetic Sockets

3/8" Square Drive Standard 3/8" Square Drive Metric 1/2" Square Drive Standard 1/2" Square Drive Metric

Uryu, Aimco, Yakota, Ingersoll Rand, Sioux and Fuji(*) Pulse Tool Part #'s
(*)Fuji models with exposed anvil behind square drive of > .385"

Atlas Copco Pulse Tool Part #'s
3/8" Square Drive Standard 3/8" Square Drive Metric

1/2" Square Drive Standard 1/2" Square Drive Metric

Pulse Tool Quick Change Adapters
Uryu / Aimco Pulse Tool Part #'s

(*)Fuji models with exposed anvil behind square drive of > .385"
3/8" Square Drive 1/2" Square Drive 3/8" Square Drive 1/2" Square Drive

Atlas Copco Pulse Tool Part #'s

Fastener     
Size Part#
3/8" AR3112(1)
7/16" AR3114(1)
1/2" AR3116(1)
9/16" AR3118(1)
5/8" AR3120(1)

11/16" AR3122(1)
3/4" AR3124(1)

13/16" AR3126(1)

Fastener 
Size Part#

10mm AR10mm13(1)
11mm AR11mm13(1)
12mm AR12mm13(1)
13mm AR13mm13(1)
14mm AR14mm13(1)
15mm AR15mm13(1)
16mm AR16mm13(1)
17mm AR17mm13(1)

Fastener 
Size Part#
3/8" AR3112(2)
7/16" AR3114(2)
1/2" AR3116(2)
9/16" AR3118(2)
5/8" AR3120(2)

11/16" AR3122(2)
3/4" AR3124(2)

13/16" AR3126(2)

Fastener 
Size Part#

10mm AR10mm13(2)
11mm AR11mm13(2)
12mm AR12mm13(2)
13mm AR13mm13(2)
14mm AR14mm13(2)
15mm AR15mm13(2)
16mm AR16mm13(2)
17mm AR17mm13(2)

Fastener 
Size Part#
1/2" AR5116(3)
9/16" AR5118(3)
5/8" AR5120(3)

11/16" AR5122(3)
3/4" AR5124(3)

13/16" AR5126(3)
7/8" AR5128(3)

15/16" AR5130(3)
1" AR5132(3)

Fastener 
Size Part#

12mm AR12mm15(3)
14mm AR14mm15(3)
16mm AR16mm15(3)
18mm AR18mm15(3)
19mm AR19mm15(3)
20mm AR20mm15(3)
22mm AR22mm15(3)
24mm AR24mm15(3)
25mm AR25mm15(3)

Fastener 
Size Part#
1/2" AR5116(5)
9/16" AR5118(5)
5/8" AR5120(5)

11/16" AR5122(5)
3/4" AR5124(5)

13/16" AR5126(5)
7/8" AR5128(5)

15/16" AR5130(5)
1" AR5132(5)

Fastener 
Size Part#

12mm AR12mm15(5)
14mm AR14mm15(5)
16mm AR16mm15(5)
18mm AR18mm15(5)
19mm AR19mm15(5)
20mm AR20mm15(5)
22mm AR22mm15(5)
24mm AR24mm155)
25mm AR25mm15(5)

Hex 
Drive Part#
1/4" ARQR-308(1)
7/16" ARQR-314(1)

Hex 
Drive Part#
1/4" ARQR-508(3)
7/16" ARQR-514(3)
5/8" ARQR-520(3)

Hex 
Drive Part#
1/4" ARQR-308(2)
7/16" ARQR-314(2)

Hex 
Drive Part#
1/4" ARQR-508(5)
7/16" ARQR-514(5)
5/8" ARQR-520(5)

Virtually ANY 
tooling accessory is 

available in our 
guided format for 

ALL manufacturers 
pulse tools !

”Guided” Sockets for pulse tool to socket applications are available for virtually any tooling accessory and 
can be designed to fit any manufacturers pulse tool!

(Simply ask your ErgoTorq Authorized Distributor for a quote or use our online quote form at www.ergotorq.com)



“ErgoTorq” 

““GGuuiiddeedd””  SSoocckkeettss  FFoorr  “ErgoTorq” PPuullssee  TTooooll  TTyyppee    
EExxtteennssiioonnss  ttoo  SSoocckkeett  AApppplliiccaattiioonnss 

(U.S. Patent #6,321,855) 

 

“Guided” 6 Point, Standard Length, Non-Magnetic Sockets

3/8" Square Drive Standard 3/8" Square Drive Metric

1/2" Square Drive Standard 1/2" Square Drive Metric

Fastener 
Size Part#
3/8" AR3112(EX3)
7/16" AR3114(EX3)
1/2" AR3116(EX3)
9/16" AR3118(EX3)
5/8" AR3120(EX3)

11/16" AR3122(EX3)
3/4" AR3124(EX3)

13/16" AR3126(EX3)

Fastener 
Size Part#

10mm AR10mm13(EX3)
11mm AR11mm13(EX3)
12mm AR12mm13(EX3)
13mm AR13mm13(EX3)
14mm AR14mm13(EX3)
15mm AR15mm13(EX3)
16mm AR16mm13(EX3)
17mm AR17mm13(EX3)

Fastener 
Size Part#
1/2" AR5116(EX4)
9/16" AR5118(EX4)
5/8" AR5120(EX4)

11/16" AR5122(EX4)
3/4" AR5124(EX4)

13/16" AR5126(EX4)
7/8" AR5128(EX4)

15/16" AR5130(EX4)
1" AR5132(EX4)

Fastener 
Size Part#

12mm AR12mm15(EX4)
14mm AR14mm15(EX4)
16mm AR16mm15(EX4)
18mm AR18mm15(EX4)
19mm AR19mm15(EX4)
20mm AR20mm15(EX4)
22mm AR22mm15(EX4)
24mm AR24mm15(EX4)
25mm AR25mm15(EX4)

”Guided” Sockets for “ErgoTorq” pulse tool type extension to socket 
applications are available for virtually any tooling accessory !

(Simply ask your ErgoTorq Authorized Distributor for a quote or use our online quote form at www.ergotorq.com)

Superior selection, performance and delivery then any competitors product at reduced cost ! 

Virtually ANY tooling accessory is available in our guided 
format to fit our “ErgoTorq” pulse tool extensions !



“Adaptors” for Uryu Pulse Tools > Apex Sockets
3/4"(.750")(QR308) AR06A(1)

13/16"(.813") AR07A(1)

7/8"(.875") AR08A(1)

3/8" Square Drive > 15/16"(.938")  = AR09A(1)

1"(1.000") AR10A(1)

1-1/16"(1.063") AR10A2(1)

1.113"(QR314) AR10A1(1)

1-1/8"(1.125") AR11A(1)

1-1/4"(1.250") AR12A(1)

0.925" (QR508) AR12A1(3)

15/16"(.938") AR13A(3)

1"(1.000") AR14A(3)

1-1/16"(1.063") AR14A2(3)

1.113"(QR514) AR14A1(3)

1-1/8"(1.125") AR15A(3)

1-1/4"(1.250") AR16A(3)

1-5/16"(1.312") AR16A1(3)

1-3/8"(1.375") AR17A(3)

1-1/2"(1.500") AR18A(3)

1-5/8"(1.625") AR19A(3)

1/2" Square Drive > 1-3/4"(1.750")  = AR20A(3)

1-7/8"(1.875") AR21A(3)

1-15/16"(1.938") AR22A(3)

2"(2.000") AR23A(3)

2-1/8"(2.125") AR24A(3)

2-1/4"(2.250") AR25A(3)

2-3/8"(2.375") AR26A(3)

2-1/2"(2.500") AR27A(3)

(U.S. Patent #6,321,855)

ErgoTorq ”Socket Adaptors”
for Uryu Pulse Tools > Apex Accessories

Apex Extension Series * Socket - Drive End O.D.  "ErgoTorq" Part #'s
1/2"(.500") AR33A

9/16"(.563") AR34A

5/8"(.625") AR35A

11/16"(.6875") AR35A1

EX-250 > 3/4"(.750")  = AR36A

(1/4" square drive extension) 13/16"(.813") AR37A

7/8"(.875") AR38A

5/8"(.625) AR38A1

3/4"(.750") AR39A

13/16"(.813") AR40A

7/8"(.875") AR41A

EX-376 > 15/16"(.938")  = AR42A

(3/8" square drive extension) 1"(1.000") AR43A

1-1/16"(1.063") AR43A1

1-1/8"(1.125") AR44A

1-1/4"(1.250") AR45A

15/16"(.938") AR46A

1"(1.000") AR47A

1-1/16"(1.063") AR47A1

1-1/8"(1.125") AR48A

1-1/4"(1.250") AR49A

1-5/16"(1.312") AR49A1

1-3/8"(1.375") AR50A

1-1/2"(1.500") AR51A

1-5/8"(1.625") AR52A

EX-508 > 1-3/4"(1.750")  = AR53A

(1/2" square drive extension) 1-7/8"(1.875") AR54A

1-15/16"(1.938") AR55A

2"(2.000") AR56A

2-1/8"(2.125") AR57A

2-1/4"(2.250") AR58A

2-3/8"(2.375") AR59A

2-1/2"(2.500") AR60A

“ErgoTorq”
Adaptors  

easily convert 
any socket into 
an ergo guided 

pulse tool 
attachment.

*PLEASE NOTE : To determine socket drive end O.D., check "C" dimensions in Apex catalogue.

“Adaptors” for Apex Extensions > Apex Sockets

For Atlas Copco
pulse tools  

simply change 
the (1) to a (2) or 

the (3) to a (5)

* Virtually any standard 3/8”, 1/2” & 3/4” drive attachment is available in pulse tool format.
(Simply ask your ErgoTorq Authorized Distributor for a quote or use our online quote form at www.ergotorq.com.)



Square Drive
A.C. Reaction Bar 

Nut Part#
"Collar"         
Part #'s

3/8" 4210 2135 00 AR200-S1

3/8" 4210 2135 00 AR200-S1T(telescoping)

3/8" 4220 1028 00 AR200-S3

3/8" 4210 1799 00 AR200-S4
1/2" 4210 2218 00 AR200-S2
1/2" 4210 2218 00 AR200-S2T(telescoping)

1/2" 4210 2135 00 AR200-S5

“ErgoTorq” 

 
 

 

"Ultralite" Standard Square Drive Extensions

3/8" Square Drive 1/2" Square Drive 

Available in 
virtually any 

length and drive 
configuration !

Atlas Copco Nutrunner Guide Extension “Collar” Part #'s
Anglehead Tools Inline Tools

Square Drive
A.C. Front Nut # or 

Thread O.D.'s
"Collar"     
Part #'s

3/8" 4210 1877 00 AR200-A1

3/8" 4210 3349 00 AR200-A2

3/8" 4210 3349 01 AR200-A2(01)

3/8" 4210 3349 02 AR200-A2(02)

1/2" 4210 3349 03 AR200-A2(03)

3/8" 4210 3349 05 AR200-A2(05)

3/8" 4210 2492 00 AR200-A5

1/2" 4210 1140 00 AR200-A6

1/2" 4210 1141 00 AR200-A7

3/8" 4220 0791 00 AR200-A9

3/8" 4220 1994 00 AR200-A10 

1/2" M34 X 0.75 LH thread AR200-A10ET

1/2" 4220 1992 00 AR200-A11

1/2" M39 X 1.0 LH thread AR200-A11ET

3/8" 4210 3860 00 AR200-A12

1/4" 4210 4036 00 AR200-A13

1/4" 4110 1407 00 AR200-A14

3/8" 4220 1742 06 AR200-A15

3/8" 4210 4446 00 AR200-A16

3/8" M27 X 0.75 LH thread AR200-A17ET

3/8" 4810 3260 00 AR200-A18

1/2" M43 X 1 LH thread AR200-A19ET

1/2" M48 X 1 LH thread AR200-A20ET

Pistol Grip Tools
Square Drive

"Reaction Bar Nut" 
Part#

"Collar"         
Part #'s

3/8" 4220-1028-00 AR200-P2

1/2" 4210-2135-00 AR200-P3

Atlas Copco Nutrunner 
“PinchPoint Protector” Part #'s

Anglehead Tools

Inline Tools

Pistol Grip Tools

Square 
Drive

A.C. Reaction Bar 
Nut Part#

"PinchPoint Protector"  
Part #'s

3/8" 4210 2135 00 PP200-S1

3/8" 4210 2135 00 PP200-S1T(telescoping)

3/8" 4220 1028 00 PP200-S3

3/8" 4210 1799 00 PP200-S4
1/2" 4210 2218 00 PP200-S2

1/2" 4210 2218 00 PP200-S2T(telescoping)

1/2" 4210 2135 00 PP200-S5

Square 
Drive

A.C. Front Nut 
Part#

"PinchPoint Protector" 
Part #'s

3/8" 4210 1877 00 PP200-A1
3/8" 4220 1994 00 PP200-A10 *
3/8" 4210 3349 00 PP200-A2

3/8" 4210 3349 01 PP200-A2(01)

3/8" 4210 3349 02 PP200-A2(02)

3/8" 4210 2492 00 PP200-A5
1/2" 4220 1992 00 PP200-A11 *
1/2" 4210 3349 03 PP200-A2(03)

1/2" 4210 1140 00 PP200-A6
1/2" 4210 1141 00 PP200-A7

Square Drive
A.C. Reaction Bar 

Nut Part#
"PinchPoint Protector" 

Part #

3/8" 4220-1028-00 PP200-P2
1/2" 4210-2135-00 PP200-P3

To determine your “Collar” & Extension Part #, simply 
add required extension information in ( )’s after the 
“ErgoTorq” “Collar” Part#, using a 3 for 3/8” drive or 4 for 
1/2” drive and the length of extension.                   

Length Part#
4" AUEX3-4
6" ARUEX3-6
8" ARUEX3-8
10" ARUEX3-10
12" ARUEX3-12

Length Part#
4" ARUEX4-4
6" ARUEX4-6
8" ARUEX4-8
10" ARUEX4-10
12" ARUEX4-12

Developing Collar & Extension Part #’s

For extension lengths longer then 12”, simply ask for a quote.

To complete your “PinchPoint Protector” Part #, simply add a / and the three decimal place O.D. of the socket 
being used, and an (S) for “Standard” Example : PP200-A1/.750(S)

“Collar’s”
Can be fitted to 

virtually any 
manufacturer’s 
nutrunner tool !

“Standard” 
PinchPoint Protector

Example : Part#- AR200-A1(3-8) for a “Collar” and 3/8” X 8” extension.
For an Ultralite extension insert a U in front of the the drive size number. eg.(U3-8) 

Up to 50% lighter then normal extensions !

(U.S. Patent #6,123,157)

Nutrunner Guided Extensions, & “PinchPoint Protectors”

Eliminate extension 
wobble, improve tool 

torque quality & 
reliability !

Eliminates the inherent 
pinchpoint that exists 

between the tool and its’ 
attachment!

Guided Extension 
“Collar”

OSHA     
Approved  
Design !

Durability tested to 100,000 cycles !



“ErgoTorq” 

Tooling Attachment “Non-Rotating” and “Slip Type” 
““AAnnttii--mmuuttiillaattiioonn//SSaaffeettyy  CCoovveerrss””  

 

 

• eliminate the potential of “Product Mutilation”
defects caused by rotating tooling attachments 
coming into contact with finished surfaces

• are available in guided format for pulse tool 
applications or standard drive format for  
nutrunner type tools

• eliminate the “Rotating Shaft Safety 
Hazard” which can cause serious injuries to 
operators who are continually exposed to

• can be designed for use with various fastener 
sizes as well as our “Ultralite” extensions to 
meet the specific needs of the customer

“Non-Rotating” Covers

“Slip Type” Covers

“Non-Rotating/Retractable”        
Covered Bit Holders

• Patent Pending design allows tooling operators 
to rundown two different size fasteners with the 
same socket without having to handle the socket

• available in guided format for pulse tool 
applications or standard drive format for 
nutrunner tools

• can be designed for use on a wide range of 
various fastener sizes to meet the needs of the 
customer

• significant cycle time reductions can be 
achieved with this “NEW” innovative product !!!

“Dual-Drive” Sockets
* “Dual-drive” sockets  
are available in virtually 
any drive size and type 
configurations.
(Simply ask your ErgoTorq
Authorized Distributor for a quote.)

“NEW”
Dual-drive sockets 

will significantly 
reduce process 

cycle times !

¼”>1/2” dr. sockets & extension up to 12”

For ordering/quotes or product information, contact your local ErgoTorq distributor, 
call Ergonomics Specialties at (519) 425-2604, visit our web-site at www.ergotorq.com 

and submit an order, request a quote or e-mail us at ergotorq@execulink.com

NEW! 
“Non-Rotating” 

anti-mutilation & 
safety covers 

provide ULTIMATE
operator safety!

Ask your local ErgoTorq Distributor for a quote or contact us directly !

Fit  any
manufacturers 
attachments !

OSHA     
Approved  
Design !


